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Uninstall current version of Quantist from computer before 
installing new version. Instructions to uninstall software are 
at the end of this User Guide.

1.	 Download Quantist software and install it on your 
computer. A Quantist licensing window will appear the 
first time you use the software.

2.	 Each software license is available for use on one 
computer only. Multiple users on the same computer 
will be able to access Quantist.

3.	 If you do have a license, skip to step 9. 
 
If you do not have a license select License Request. 
Fill out the form and choose Evaluation License or a 
Full License. 
 
Complete and save the form on the computer the 
software will be installed on.

Minimum Software Requirements

Processor 3.0 GHz i7 - 6th gen.

RAM 8 GB

Hard Drive 256 GB

Operating System Windows 11

Screen Resolution 1600x900 24 bit color

4.	 Quantist will generate a license request (.req) file.

5.	 Email the request to: 
software.licensing@bio-techne.com 

6.	 You will receive a license within 1 business day.

7.	 Save the license on the computer used to request it. 
Choose the file location that works for you. 
Make sure that you are able to navigate to the license 
via the Quantist software.

8.	 After you have received the license, open Quantist 
software. The licensing window will appear.

9.	 Select Install License File.

10.	 Navigate to the license that you saved on the computer 
and select it. 
Your copy of Quantist is now licensed. The License 
Type window will say “Full” or “Evaluation”. The license 
status will say Valid License. 
You can close this window if it does not automatically.

1.0 
Install Quantist 2.0

mailto:software.licensing%40bio-techne.com?subject=
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11.	 Open Quantist to start.

12.	 Select Help > About to view the software version and 
license status.

13.	 Click “…” to view the software licensing window.

Quantist compatible filetypes:

• CSV files 
• Quantist files

Select Edit to:

• Undo (Ctrl + Z) 
• Redo (Ctrl + Y)

Select Help to:

• Download the Quantist User Guide 
• Generate a Quantist diagnostic file 
• View software version and license status

Help > About Software

Software Licensing Window

14.	 If moving from an Evaluation License to a Full License, 
repeat Steps 3-10 and reference your Sales Order 
number when filling out License Request form.

Installation Continued
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1.	 Launch Quantist software.

2.	 Import CSV or Quantist files: 
	 Drag and drop file into the Runs Control window 
	 or 
	 File > Open Runs.

3.	 Green file icons are active. 
Grey file icons are inactive. 
 
Quantist file icon:	 Luminex® xPONENT® file icon: 

4.	 Shift + click to select multiple files from a folder.

5.	 Quantist imports up to 50 CSV files. 
Imported files will appear in the left column/window. 

2.0 
Data Analysis Using 
Quantist Software

Toggle multi-run view 
horizontal/vertical

Open file

Toggle to view 
up to 4 runs 

simultaneously

Show 
options

Hide 
options

Run File Icon

Luminex® xPONENT® files

Grey icons are inactive. 
Click a grey icon to make active.

Click X to completely close 
the .CSV or .Quantist file.

Quantist File

Green indicate an active file. 
Displays are showing details 
related to this file’s options.

File Inactive (click to activate) 
File Option Inactive

File Active 
File Option Inactive (click to activate)

 

File Active 
File Option Active

An active option has related window 
pane(s) displaying customizable details.

File Options

Open option’s display pane 
 
Close display pane

How to Utilize the 
Runs Control Window
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6.	 Select Run Information for an overview of each file. 
 
Click a section header to expand or collapse. 
 
Notes section is an editable field to add any run notes.

Single Analyte Results

Multi-Analyte Results

Analytes Panel

Run Information

Well Assignments

7.	 To begin, select Analytes Panel to confirm 
or update analyte assignment to bead region. 
 

C. Use the right panel (Table Options) 

Single Analyte Results

Multi-Analyte Results

Analytes Panel

Run Information

Well Assignments

• Move target analyte up or down 
• Sort rows by analyte or bead region 
• Set units for selected rows 
• Copy rows to or from clipboard 
• Reset all rows to be included

AA
BB

C

A.	 The Analyte name and Units columns are 
editable. Toggle the “included” box to include 
the target analyte/bead region or not.

B.	 Select the Analyte Name or Bead Region column 
headers to arrange columns in alphabetical or 
numerical order, respectively.
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Single Analyte Results

Multi-Analyte Results

Analytes Panel

Run Information

Well Assignments

to: 7.	 Assign blank wells: 
Blank wells are indicated with a grey diamond. 
Blanks will be detailed in the rightmost window.

A.	 Set the replicate number in the Replicate Count 
field of the center window.

B.	 Toggle the arrow vertical or horizontal to choose 
the direction of replicates.

C.	 Highlight wells that contain standards.

D.	 Click Standard. 
Blue circles will appear in selected wells. 
Numbers in blue circles indicate which standard is 
in each well.

8.	 Assign Standards:

E.	 Use the right window to set the highest standard. 
High To Low (Lowest Number is the High 
Standard). Low To High (The highest number is the 
High Standard). 
 
The serial dilution will automatically populate 
based on the highest standard and the standard 
divisor.  Serial Dilution is recalculated when a 
standard is deleted. Except for the case of the High 
Standard being deleted. 
 
Use the Standard Divisor window to set the 
standard serial dilution.If no divisor is entered, you 
can manually enter the serial dilution series for 
each analyte.

F.	 Otherwise, the highest standard must be entered 
for each analyte.

Control Unknown

Single line 
indicates no dataBlank

Standard

Highlighted 
empty well 

(details window 
pane is open)

Assign Wells

1.	 Highlight desired wells 
contiguous area: shift + click 
discontiguous areas: ctrl + click

2.	 With well(s) highlighted (light green), 
click the tool bar legend to assign type

3.	 Active wells are indicated with double line. 
To edit details of a well see windows to right side. 

Modify Well Plate Details

Clear wells

1.	 Select the well(s)

2.	 Click the trash can icon
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9.	 Assign Controls:

A.	 Set replicate number at the top left of the center 
window. 

B.	 Toggle the direction of replicates using the arrow. 

C.	 Highlight the control wells. 

AA BB DD

GG

E

H

D.	 Select control. 
Orange squares will appear in each of the selected 
wells. The controls will appear in the right window.

E.	 Add the concentration for each set of control 
replicates for each analyte.

10.	 Assign Unknowns:

A.	 Set replicate number at the top left of the center 
window.

G.	 Assign Unknown wells. 
Blue triangles will appear in each selected well. 
Details of Unknown wells is open at right. 

 
If the same dilution factor exists for multiple 
samples, highlight all applicable wells, type in 
dilution, and press enter.

H.	 Add dilution factor for unknowns in right column.

11. Assign Multiple Assay Sets

A. Highlight wells in Assay Set.

B. Click Assay Set drop down to add new assay set.

C. Assigned wells will highlight blue for Assay Set 1, green for Assay Set 2, pink for Assay 
Set. 3, orange for Assay Set 4, and yellow for Assay Set 5.
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You can evaluate standard curve quality by assessing 
recovery and Coefficient of Variation (%CV). 
 
You can also configure standard curve properties such as 
curve fit, curve weighting, and recovery range.

Single Analyte Results

Multi-Analyte Results

Analytes Panel

Run Information

Well Assignments

12.	 Within run controls menu click Single Analyte Results.

	 Two windows are open at center: 
The standard curve for each analyte (top) 
Data for the analyte (bottom)

Analyte details

Analyte standard curve

DATA QUALITY CHECK



11

13.	 Configure the Curve for each standard curve 
using the right window.

A.	 Toggle between analytes using the Analyte drop-
down button.

D.	 Toggle the Curve Weighting button to select 
curve weighting: none, 1/Y, or 1/Y2.

	 Appropriate curve weighting is required to 
ensure that all data contribute equally to the final 
regression curve.  Choose 1/Y2 to compensate 
for high variability at the low end of the standard 
curve.

E.	 The Conc. CV Limit button allows you to set the 
percent coefficient of variation limit. 
Options range from no limit to 5% CV.

F.	 Toggle the Recovery Range button to choose the 
appropriate recovery range.

B.	 Toggle between analytes using the Analyte drop-
down button. Toggle between Assay Sets using 
the drop-down button. 

C.	 The Current Curve Data section of the right 
window shows all curve data, including Curve fit, 
weighting, recovery range, LLOQ, ULOQ, A, B, C, 
D, G, units.

	 4PL 
a = estimated response at zero concentration  
b = slope factor  
c = mid-range concentration (C50)  
d = estimated response at an infinite concentration

	 5PL 
a = estimated response at zero concentration  
b = slope factor  
c = mid-range concentration (C50)  
d = estimated response at infinite concentration  
g = asymmetry factor

A
B
D

C
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14.	 Configure the Curve (continued) 15.	 Data Analysis Optimization - Remove Outliers

Assess Recovery

	 Scroll across the table in the bottom center 
window to view details in: the % Recovery column 
and the Included column. 
 
For any standard that is outside of the selected % 
recovery range, confirm that the box is unchecked 
in the Included column. 
 
The right window (in the Configure Curve section) 
there is an option to Remove Outliers Based on 
Recoveries for the current curve or all curves.

Assess %CV  
 
Examine the % CV column and exclude samples 
that are outside of the acceptable %CV range by 
unchecking the included box.

G

H

G.	 The Graph Options section of the right window 
allows you to:

H.	 The Table Options section of the right window has 
several functions:

• Visualize controls and unknowns 
   on the standard curve.

• Expected standards are indicated by  
   dark blue circles.  
   Observed standards are indicated by  
   dark blue stars.  
   Unknowns are indicated by light blue triangles. 
   Expected controls are indicated by  
   orange squares.  
   Observed controls are indicated by orange  
   plus signs.

• Toggle on/off  logarithmic scale of X and Y axis.

• Copy the standard curve to a clipboard.

• Expand/collapse all rows in the center bottom 
   table. Triangles on the far left of rows in the  
   bottom center. Windows can also be toggled to  
   expand individual replicate rows.

• Copy aggregates or replicates to a clipboard for 
   pasting elsewhere.

• Reset standards, controls, and unknowns.
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16.	 Select Multi-analyte Results to sort and compare 
sample data across target analytes.

B.	 The Multi Analyte Results Table Options section 
in the right window has several operations.

	 • Expand/collapse row operations of center table 
• Copy aggregates or replicates to the clipboard 
• Reset standards unknowns or controls

A

B

C

C.	 The All Curves Data section of the right panel 
contains standard curve data for each analyte 
including, Fit, Weighting, Recovery Range, LLOQ, 
ULOQ, R2, A, B, C, D, G, Units.

	 A = estimated response at zero concentration  
B = slope factor 
C = mid-range concentration (C50) 
D = estimated response at infinite concentration  
G = asymmetry factor

MFI: 
Mean Fluorescent Intensity. 
Excluded data is faint gray.

MFI % CV: 
MFI percent coefficient of variation. 
Excluded data is absent.

Net MFI: 
Sample MFI-background well MFI. 
Excluded data is faint gray.

Concentration: 
Sample concentration relative to the standard 
curve. Excluded data is faint gray. Data outside of 
established curve parameter limits is brown.

Concentration Status: 
Is the concentration > or < LLOQ or ULOQ? 
Data outside of these parameters in indicated by 
<LLOQ, >LLOQ, <ULOQ,>LLOQ.

Concentration % CV: 
Concentration percent coefficient of variation. 
Excluded data is absent.

Expected concentration: 
Standards for each analyte. 
Excluded data is absent.

% Recovery:  
(Observed sample concentration/expected sample 
concentration) X 100%. Excluded data is faint gray.

Dilution Factor: 
Dilution factor for unknowns. 
Excluded data is faint gray.

Bead count: 
Number of beads counted in specified bead 
region. Excluded data is faint gray.

A.    The following data can be viewed across all target 
analytes on an assay by using the Selected Field drop-
down button in the right window. 

Single Analyte Results

Multi-Analyte Results

Analytes Panel

Run Information

Well Assignments Note, these results are the same as those described in the 
Luminex xPonent software manual.

Double click on each mean to view replicates. 
Double click on the mean again to hide individual 
replicates. Double click on individual replicates to include 
them or remove them.

The included column contains a check if data is included. 
The Included column is empty or contains a black square if 
data is excluded.

The black caret on the far left side of the Sample column 
can be toggled to view replicates as well.
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17.	 Inter-assay comparison 
Make inter-assay comparisons to ensure that data is 
consistent across assays over the long term.

18.	  If the analyte/bead region assignments are identical, 
plate layouts can be copied from one plate to the next 
plate in the Well Assignments view using the keyboard 
short cuts “ctrl-c” to copy and “ctrl-v” to paste.

A.	 To make inter-assay comparisons, import up to four 
CSV files. All options in the Runs control window 
can be simultaneously viewed across four runs. 
This works best on large monitors.

B.	 Select the button containing 2 overlapping squares 
in the grey area at the top of the left window (multi-
view button). When selected, the button changes 
color to blue.

C.	 To compare standard curves, select the Single 
Analyte Results from both assays. 
 
The center window will simultaneously visualize the 
standard curve and data for two runs.

D.	 Toggle the Analyte button in the right windows 
to select the same analyte for comparison. The 
windows on the right are scrollable.

E.	 Use this option to compare the following data: 
	 Background signal 
	 MFI 
	 Curve Fit

F.	 Inter-assay comparisons can also be made using 
the Multi-analyte Results.

G.	 Toggle the Selected Field button at the top of the 
right windows to view the same data field across all 
analytes on both runs.

C

B

G

View options (right windows) 
Click arrow to expand 
Click X to close

Single Analyte Results
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20.	 The Quantist Run Report contains the following 
information:

4.0 
UNINSTALL QUANTIST

3.0 
UNDO/REDO

1.	 Select the windows start icon.

2.	 Select the settings cog in the menu.

3.	 Select apps in the windows settings menu.

4.	 Scroll down to the Quantist software icon and select it.

5.	 Select uninstall.

Undo actions using Control + Z and redo actions using 
Control + Y. Undo and redo actions can also be completed 
using the buttons in the Edit menu in the top left corner. 

Conc: Concentration 
Status: Is the sample within the ULOQ and LLOQ? 
Conc CV%: Concentration coefficient of variation 
% Recovery: (observed sample concentration/
expected sample concentration) X 100% 
DF: Dilution Factor for unknowns 
N: Number of replicates 
Included: Is the sample included in the analysis 
Is Aggregate: True= mean of replicates, False= 
individual replicates 
Bead count: Number of beads counted in specified 
bead region

19.	 Export data into a Quantist run report.

	 To export data into excel, select File/Export “filename”. 
You can also simultaneously export all files to excel.
Quantist will export a .xlsx file.

A.	 Information Tab 
This tab contains information about the file, 
software, and hardware.

B.	 Summary Tab 
This tab summarizes the analyte concentrations 
(Conc) for each well. Samples that are outside of 
the limits of quantitation are in a lighter color font.

C.	 Curves Tab 
This tab contains standard curve plots for each 
analyte as well as curve fit data.

D.	 Analyte Tabs 
Each analyte has its own tab that contains the 
following: curve plot, curve fit data, and plate data.

Plate data include: 
Sample: Background, Standard, Control, Unknown 
Use: Blank, Standard, Control, Unknown 
Wells: Well location 
MFI: Mean Fluorescent Intensity 
MFI CV%: MFI coefficient of variation 

A B C D
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